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Welcome to Adams 2007 r1
Thank you for purchasing Adams 2007 r1 products. The Adams 2007 r1® is motion simulation software 
for analyzing the complex behavior of mechanical assemblies. With it, you can test virtual prototypes and 
optimize designs for performance, safety, and comfort, without having to build and test numerous 
physical prototypes.

The major aspects of Adams include the ability to transfer loads and motion information from Adams to 
MD Nastran for stress, durability, vibration and harshness analysis.
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Preface
About MSC.Software

Overview
MSC.Software Corporation is the leading global provider of virtual product development (VPD) tools, 
including simulation software and professional services. MSC.Software helps companies make money, 
save time, and reduce costs associated with designing, testing, producing, and supporting manufactured 
products.

MSC.Software works with thousands of companies worldwide, in hundreds of industries, to develop 
better products faster by using information technology, software, and services to enhance and automate 
the product design and manufacturing process. Simulating your product performance reduces 
development costs, time to market, and warranty costs. 

About Virtual Product Development and Adams
You’ve heard it before: manufacturing companies today face intense global competition, demanding 
customers, fragmented markets, increasing product complexity, compressed product cycles, price and 
profit pressures, strict regulatory and liability environments, systems integration and supply chain issues, 
skyrocketing costs of testing and physical prototyping, and on and on…

What you don’t often hear, though, is a strategy for enabling your company to improve your new product 
development process to meet these challenges. 

Whether you are delivering airplanes, automobiles, ships, biomedical devices, golf clubs or children’s 
toys to your customers, MSC.Software’s goal is to help you improve your new product development 
process, allowing you to be significantly better at your concept development, design, testing, and 
production activities through the application of VPD. 

VPD is an environment that uses an integrated combination of both simulation software technology and 
traditional techniques to design, test, manufacture, and support products. The result is that cost-effective 
designs that meet all performance, safety, durability, and reliability requirements can be brought to 
market in less time and for less cost.

Adams, as part of VPD, is focused on enhancing your ability to make better product development 
decisions, explore innovative design alternatives, and consistently get the product right. It is the world's 
most widely used mechanical system simulation software. It enables you to produce virtual prototypes, 
realistically simulating the full-motion behavior of complex mechanical systems on your computers and 
quickly analyzing multiple design variations until an optimal design is achieved. This reduces the 
number of costly physical prototypes, improves design quality, and dramatically reduces product 
development time.
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Technical Support
For help with installing or using an MSC.Software product, contact your local technical support services. 
Our technical support provides the following services:

• Resolution of installation problems
• Advice on specific analysis capabilities
• Advice on modeling techniques
• Resolution of specific analysis problems (e.g., fatal messages)
• Verification of code error.

If you have concerns about an analysis, we suggest that you contact us at an early stage.

You can reach technical support services on the web, by telephone, or e-mail.

Web
Go to the MSC.Software website at www.mscsoftware.com, and click on Support. Here, you can find 
a wide variety of support resources including application examples, technical application notes, available 
training courses, and documentation updates at the MSC.Software Training, Technical Support, and 
Documentation web page.

In addition, we provide several excellent sources of online information:

• Knowledge Base - Find solutions to problems in this repository of troubleshooting tips, 
examples, and frequently asked questions. To access the knowledge base, go to:
http://support.mscsoftware.com/kb/

• VPD Community - The VPD community is where to go when you are looking for peer support, 
as well as technical expertise. Many of our consultants, developers, and technical support staff 
monitor the forums. To sign up for the forums, go to:
http://forums.mscsoftware.com

Then:
• To view the Adams discussions, select Adams.
• To view product alerts and company news and events, select MSC News.

http://support.mscsoftware.com/kb/
http://forums.mscsoftware.com
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Phone and Fax

Email
Send a detailed description of the problem to the email address below. You should receive an 
acknowledgement that your message was received, followed by an email from one of our Technical 
Support Engineers.

Training
The MSC Institute of Technology is the world's largest global supplier of CAD/CAM/CAE/PDM 
training products and services for the product design, analysis and manufacturing market. We offer over 
100 courses through a global network of education centers. The Institute is uniquely positioned to 
optimize your investment in design and simulation software tools.

Our industry experienced expert staff is available to customize our course offerings to meet your unique 
training requirements. For the most effective training, The Institute also offers many of our courses at 
our customer's facilities.

United States
Telephone: (800) 732-7284
Fax: (714) 784-4343

United Kingdom
Frimley, Camberley
Surrey, United Kingdom

Telephone: (44) (1276) 60 19 00 
Fax: (44) (1276) 69 11 11

Munich, Germany
Telephone: (49) (89) 43 19 87 0
Fax: (49) (89) 43 61 71 6

Tokyo, Japan
Telephone: (03)-6911-1200
Fax: (03)-6911-1201

Rome, Italy
Telephone: (390) (6) 5 91 64 50
Fax: (390) (6) 5 91 25 05

Paris, France
Telephone: (03)-6911-1200
(03)-6911-1201

Moscow, Russia
Telephone: (7) (095) 236 6177
Fax: (7) (095) 236 9762

Gouda, The Netherlands
Telephone: (31) (18) 2543700
Fax: (31) (18) 2543707

Madrid, Spain
Telephone: (34) (91) 5560919
Fax: (34) (91) 5567280
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The MSC Institute of Technology is located at:

2 MacArthur Place
Santa Ana, CA 92707
Phone: (800) 732-7211 
Fax: (714) 784-4028

The Institute maintains state-of-the-art classroom facilities and individual computer graphics laboratories 
at training centers throughout the world. All of our courses emphasize hands-on computer laboratory 
work to facility skills development. 

We specialize in customized training based on our evaluation of your design and simulation processes, 
which yields courses that are geared to your business.

In addition to traditional instructor-led classes, we also offer video and DVD courses, interactive 
multimedia training, web-based training, and a specialized instructor's program.

Course Information and Registration
For detailed course descriptions, schedule information, and registration call the Training Specialist at 
(800) 732-7211 or visit www.mscsoftware.com. 
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Preface
Internet Resources
MSC.Software (www.mscsoftware.com)
MSC.Software corporate site with information on the latest events, products and services for the 
CAD/CAE/CAM marketplace.

MSC.Software Store (store.mscsoftware.com)
store.mscsoftware.com is a virtual marketplace where clients can find engineering expertise, and 
engineers can find the goods and services they need to do their job
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Overall Product Improvements
There are many reasons why you should use Adams, including:

Product Integration
• Nastran Modal Export for frequency domain stress recovery in MSC.Nastran.
• Support for Adams/Car applications in Adams/Solver (C++) to obtain improved robustness, 

greater accuracy, and further opportunities for high performance through parallel processing.

New Capabilities
• Faster simulations for sphere-to-solid 3D contact applications
• Run-time aggregate mass computation for monitoring center-of-mass and inertia of assembled 

model or sets of parts.
• Tire testrig for visualizing effects of tire properties and to compare tire model performance.
• Dynamic suspension testrig in Adams/Car which allows RPC III file input for motion and force.
• Stress and strain frequency response function (FRF) for flexible body vibration analysis.

Other Additions
• Reference guide for Adams/View command language.
• Improved quality across entire Adams software suite.
• File collection utility for remote job submission (experimental feature).
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What’s New
What’s New
The following are highlights of additions to existing products. For Known Issues and updated Release 
Notes, look for Adams 2007 r1 on the Support site

http://support.mscsoftware.com

Adams/Car

Dynamic Suspension Testrig
Adams/Car offers you the possibility to run dynamic suspension analyses. This event is available from 
the Simulate Menu under Suspension Analysis -> Dynamic.The testrig has been modified to support 
vertical motions and forces on the left and right jacks. You can define arbitrary solver functions for each 
jack, or reference an RPCIII file. Choosing the option 'arbitrary' function, allows you to enter a runtime 
function expression that will be used by the motion/force. Typically the function expression will be a 
function of time, for example an impulse, a simple harmonic function or a frequency sweep. 
Alternatively, by choosing an RPCIII file as input, your motion/force will be governed using a durability 
function called INTERP. An example RPCIII file has been added to the loadcases.tbl car shared database 
table. The INTERP function returns the interpolated value (using cubic interpolation) of the spline 
statement. The spline references the RPCIII file. You will have to select the type of vertical excitation: 
displacement, acceleration, velocity or force. In addition to the vertical jack motions/forces, it is possible 
to define a function for steering motion therefore combining the vertical excitation with steering sweeps. 

For an example, see Knowledge Base Article 1-43315482.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315482

C++ Solver Support for Adams/Car Simulations
Any modeling methods or entities supported by the Fortran Solver and used by Adams/Car that were not 
supported in past releases of C++ Solver have now been added to the C++ Solver. We expect that you 
will see improved solver robustness for many models as well as new opportunities for performance 
improvement with the availability of features unique to the C++ Solver, including the HHT integrator, 
adaptive Jacobian pattern, and SMP for multi-threaded parallel processing.

For an example, see Knowledge Base Article 1-KB12723.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-KB12723

The Adams/Solver will switch to the C++ Solver as the default solver in a future release of the 
Adams/Car. In the meantime we encourage you to begin using the C++ Solver for your simulations and 
to give us your feedback.Please log on to our web portal at 
http://support.mscsoftware.com/servicerequest/ to submit your feedback and/or suggestions for 
improvement. 

http://support.mscsoftware.com/servicerequest/
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315482
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-KB12723
http://support.mscsoftware.com
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Solver Settings in Assembly File (1-FDB47206)

Now you can define equilibrium and dynamics solver settings in your assembly and be sure that the 
values will be associated to the assembly and saved in the .asy file. This ensures data and simulation 
results persistency in case you defined solver settings different than the defaults ones. The assembly file 
writer now outputs the values of the equilibrium and integrator settings into the assembly file if they are 
different than the default ones. Once you reopen that assembly file the settings will be modified. The list 
of solver parameters supported in the assembly file follows below: 

INTEGRATOR [string] 
TLIMIT [real] 
EQUILIBRIUM_MAXIT [integer] 
FORMULATION [s] 
CORRECTOR [s] 
INTERPOLATE [s] 
EQUILIBRIUM_ERROR [r] 
ALIMIT [r] 
STABILITY [r] 
IMBALANCE [r] 
DYNAMICS_ERROR [r] 
HMAX [r] 
HINIT [r] 
HMIN [r] 
ADAPTIVITY [r] 
DYNAMICS_MAXIT [i] 

Support for Static Only Analysis (1-FDB52544, 1-FDB25771)
Adams/Car now offers a simple static only full vehicle analysis. This event is available from the 
Simulate Menu under Full-Vehicle Analysis ->Static and Quasi-Static Maneuvers -> Static 
Equilibrium, and supports all the different quasi-static prephase set-up options:

• None
• Normal 
• Settle
• Straight
• Skidpad

Static-only full vehicle analysis is useful for debugging models or for extracting data from models. The 
analysis results do not contain time-varying information, but only the initial configuration and the 
equilibrium positions. Animation should display frames corresponding to the various equilibrium 
configurations. Finally, you can optionally perform a linear analysis following any of the static prephase 
analyses. 
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Documentation

Example for calculating Driving Machine braking parameters
To obtain good closed loop braking control of your vehicle model you must compute parameters needed 
by the Driving Machine. This article explains how to calculate the maximum brake torques for your 
vehicle, and how to ensure that for a braking demand of 100 your brake subsystem produces the 
maximum brake torque. 

Obtaining good closed-loop braking control using the Driving Machine Solution#: 1-24626031.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-24626031

Documentation of Event Consubs
Documentation for event consubs is now available, please refer to the “Controlling Analyses using 
CONSUBs” section of “Running Analyses” in the Adams/Car Help.

• Con950 (suspension analysis)
• Con910, 917 (Vel IC) 
• Con900 (Force adjust) 
• Con1010,1020,1030 (Qstatic)

Adams/Car Ride

Maintenance
This release of Adams/Car Ride is primarily a maintenance release where the focus has been on 
improving the quality and robustness of Adams/Car full-vehicle simulations.

Adams/Chassis

Subsystem & Property Usability Improvements
Several usability improvements have been implemented in the graphical user interface and at a 
subsystem level to make things easier for you when dealing with component properties.

1. Property files merged to subsystem files
In previous releases of Adams/Chassis the subsystem file contained only a reference to the 
property file. Now the properties themselves may be embedded within the subsystem file, for 
example the .xml file would contain a new tag <SpringProperties...> under which would be the 
spring properties data.

2. Enhanced graphical user interface

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-24626031
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Managing of property files used by a subsystem is made easier with this release. A "Create New" 
button can be used to define new component properties and the "Import" and "Export" buttons can 
be used to easily share properties with other Adams/Chassis users. Multiple properties for 
components can now be included in your subsystem. Each set of properties you include will be 
presented on the screen in a list format with a handy checkbox for selecting the property you want 
to use.

3. Fewer separate tabs
Adams/Chassis interface uses fewer separate tabs so as to achieve a nicer organization of property 
information that is capable of fitting on one screen.
For an example, see Knowledge Base Article 1-43315518. 

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315518
4. Modified XML file formats for easy readability

The format of .xml files have been updated to make them easier to read. File content that may 
have been presented in a very long line can now be broken up into smaller fragments on separate 
lines.
For an example, see Knowledge Base Article 1-43315524. 

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315524

C++ Solver Improvements
Adams/Solver (C++) has seen many improvements for running vehicle models created in Adams/Car. 
This effort in making the Adams/Car Solver more robust is expected to, in turn, benefit classes of 
Adams/Chassis models. Please consider using the C++ Solver in this release and providing us with 
feedback on your experiences. Please log on to our web portal at 
http://support.mscsoftware.com/servicerequest/ to submit your feedback

Adams/Controls

Support for MATLAB Release 14SP3 and 2006b

MATLAB
The supported versions of MATLAB are R14SP3 (MATLAB 7.1, Simulink 6.3) and 2006b. Please note 
that IBM AIX platforms are not supported by The MathWorks in MATLAB R14SP3 and 2006b. For 
more information on R14SP3 platforms and compatibility, see 
http://www.mathworks.com/support/sysreq/release14sp3/unix.html

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315518
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315524
http://support.mscsoftware.com/servicerequest
http://www.mathworks.com/support/sysreq/release14sp3/unix.html
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Adams/Driveline

Maintenance
This release of Adams/Driveline is primarily a maintenance release where focus has been on improving 
the quality and robustness of the solution aspects of full-vehicle Adams/Car simulations. Adams/Solver 
(C++) has seen many improvements for running vehicle models and these are expected to, in turn, benefit 
many classes of driveline models.

Adams/Durability

Maintenance
This release of Adams/Durability is primarily a maintenance release where focus has been centered on 
improving the quality and robustness of the solution aspects of durability simulations. Adams/Solver 
(C++) has seen many improvements for running vehicle models, especially Adams/Car models, and 
these enhancements are expected to, in turn, benefit other classes of durability models.

Adams/Flex

Maintenance
This release of Adams/Flex is primarily a maintenance release where focus has been on improving the 
quality and robustness of the solution aspects of flexible body simulations. Adams/Solver (C++) has seen 
many improvements for running Adams/Car models and these are expected to, in turn, benefit many 
classes of flex-body models.

Adams/SmartDriver

Maintenance
This release of Adams/SmartDriver is primarily a maintenance release where focus has been on 
improving the quality and robustness of the solution aspects of full-vehicle Adams/Car simulations. 
Adams/Solver (C++) has seen many improvements for running vehicle models and these are expected 
to, in turn, benefit models that use Adams/SmartDriver.

Tip: If you want to co-simulate with MATLAB and you are running Adams/Controls on one of 
the platforms that is not supported by MATLAB, use TCP/IP communication.This allows 
Adams/Controls to communicate with MATLAB even though the codes are running on 
different platforms. Please refer to Adams/Controls help to learn more about TCP/IP 
communication using the Adams Daemon Process (adams_daemon.py).
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Event Builder Usability (1-FDB53677)
The event builder layout in Adams/Car has been reorganized with the intent to reduce the dimension of 
the widget (too big for 1024x768 resolution on Windows) and to better organize the various widgets. In 
particular:

• Moved Machine, Human and SmartDriver widgets into the Demand tabbed containers. 
• Reorganized the complete layout of the mini-maneuver
• Made non-editable fields/widgets grayed out
• Enhanced the SmartDriver Data widget to include missing parameters that were originally 

editable only by opening the file in a text editor.

Documentation

Example for calculating Driving Machine braking parameters
To obtain good closed loop braking control of your vehicle model you must compute parameters needed 
by the Driving Machine. This article explains how to calculate the maximum brake torques for your 
vehicle, and how to ensure that for a braking demand of 100 your brake subsystem produces the 
maximum brake torque. 

Obtaining good closed-loop braking control using the Driving Machine Solution#: 1-24626031.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-24626031

Adams/Solver (C++ and FORTRAN)

Analytical Representation for Spheres in 3D Contact
Perfect spheres (i.e. Ellipsoids with equal radii) will no longer be facetized when using the RAPID 
contact engine. This enhancement will help to speed up the contact detection for some classes of models. 
If you have a sphere-to-solid contact, the sphere will be treated analytically (not faceted) and the solid 
will be faceted. This often improves the solver performance for models that contain a large number of 
spheres in persistent contact with complex solid geometry shapes, such as one might find in a 
recirculating ball mechanism, for example.

For an example, see Knowledge Base Article 1-42940901. 

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-42940901

Run-Time Aggregate Mass Computation
Access to aggregate mass computation during run-time is now possible when using the 
ADD_MASS_PROPERTY and BODY_MASS_PROPERTY utility user-subroutines.

• BODY_MASS_PROPERTY: accepts specifiers for either a single part or the entire Adams 
model and returns to the caller the mass properties (mass, center-of-mass, and inertia tensor) for 
that part or model.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-24626031
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-42940901
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• ADD_MASS_PROPERTY: accepts the mass properties for two parts or sets of parts and 
returns the mass properties of the aggregate set.

These utility subroutines are expected to be used only for monitoring and control purposes and may only 
be called from REQSUB, SENSUB, SEVSUB, and CONSUB.

Only Adams/Solver (C++) supports inclusion of FLEX_BODY in the aggregate mass computation; the 
PART and POINT_MASS are supported in both solvers.

For an example, see Knowledge Base Article 1-42498511. 

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-42498511

New Utility Subroutines
Additional utility subroutines have been added and documented, including a collection developed 
especially for users of the GSE (General State Equation) subroutine:

• GET_GRAVITY: returns the current Adams/Solver gravity vector, as specified by the 
ACCGRAV statement or command.

• GSE_SET_IMPLICIT: used to specify the implicit/explicit character of the equations 
governing the GSE. The formulation of a GSE can be changed without changing the 
corresponding Adams model dataset (.adm).

• GSE_SET_ND: used to specify the number of discrete states in the GSE. The number of 
discrete states in a GSE can be changed without changing the corresponding Adams model 
dataset (.adm).

• GSE_SET_NS: used to specify the number of continuous states in the GSE. The number of 
continuous states in a GSE can be changed, overriding any value of NS specified in the GSE 
statement.

• GSE_SET_SAMPLE_OFFSET: used to specify the simulation time at which the sampling of 
the discrete states is to start. Gives the GSE the ability to set the SAMPLE_OFFSET attribute 
itself.

• GSE_SET_STATIC_HOLD: used to enforce the condition that continuous states are or are not 
allowed to change during a static or quasi-static simulation. The value returned by 
GSE_SET_STATIC_HOLD will override any value of STATIC_HOLD specified in the GSE 
statement.

File Collection Utility for Remote Job Submission (Experimental Feature)
For your convenience an experimental Python utility (RunAdamsSolver.py) has been provided in the 
install_dir/solver directory which can be used to collect together all of the files needed to run 
the Adams simulation on a remote machine.

This is also useful when your Adams dataset (.adm) contains references to several other files that may 
reside in a variety of subdirectories and you simply want to package it all up for delivery to another user.

To run the utility on Windows:

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-42498511
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adams07r1 python topdir/solver/RunAdamsSolver.py

Tip: 'topdir' is the installation directory of Adams and can be determined by issuing "adams07r1 -
top".

Example:
adams07r1 python C:\MSC~1.SOF\MSC~1.ADA\2007R1~1\solver/RunAdamsSolver.py

We do welcome your feedback on the utility and would like to hear from you. Please log on to our web 
portal at http://support.mscsoftware.com/servicerequest/ to submit your suggestions for improvement. 
When adding a new request, please be sure to choose the request type of Enhancement.

For an example, see Knowledge Base Article 1-43084311. 

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43084311

Adams/Tire

Tire Test Rig
With the new tire test rig available in Adams/Car you are able to better visualize the effects of tire 
properties and to compare tire model performance. Given a tire property file and a schedule of inputs you 
can easily produce plots of tire characteristics. You can access this feature in Adams/Car from the menu: 
Simulate -> Component Analysis -> Tire Testrig.

By means of this highly automated interface you create an event with an arbitrary number of analyses 
and tire property files; selecting the run-it button runs all analyses and automatically generates 27 plots. 
Just save the tire testrig events as .xml files and you can rerun the event over and over again on different 
tire models and datasets.

This feature helps you in analyzing the quality of tire models and tire datasets, giving you insight into:

• Force & Moment characteristics: constant load and camber, slip sweeps
• Cleat testing: constant axle height
• Moving road: vertical (poster), lateral, longitudinal, cambered
• Locked wheel controller
• Spin motion

For an example, see Knowledge Base Article 1-43315511.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315511

Note:  This utility is intended to replace previous prototypes that were made available through the 
knowledge base article 1-22403221. 
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-22403221

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43084311
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-22403221
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315511
http://support.mscsoftware.com/servicerequest/
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Transient Modeling for all Tire Models (1-FDB52994)
Transient modeling similar to PAC2002/PAC-TIME has been added to Fiala, 5.2.1, PAC89 and PAC94 
tire models. When rolling the tire behaves like a damper, with its force response depending on slip 
speeds; when standing still the tire should respond like a spring (force response should depend on tire 
deflection). A method to achieve this is by introducing the relaxation method (transient) as has been done 
for PAC2002, PAC_MC, and UA-Tire tire models. Because of this transient the tire will act as a spring 
when standing still. Ftire and SWIFT have similar behavior when standing still. This enhances spring 
behavior of the tire at zero speed and also ensuring that vehicle models on the four-poster with these tire 
models will also work well.

C++ Solver Support for Tires
Any modeling methods or entities supported by the Fortran Solver and used by Adams/Tire that were not 
supported in past releases of C++ Solver have now been added to the C++ Solver. We expect that you 
will see improved solver robustness for many models as well as new opportunities for performance 
improvement with the availability of features unique to the C++ Solver, including the HHT integrator, 
adaptive Jacobian pattern, and more.

Friction Ellipse Method for Pacejka Tire
The friction ellipse method for combined slip has been implemented for the Pacejka tire models: 
PAC2002, PAC-TIME, PAC-MC. This is an alternative to the cosine 'weighing' method which had 
already been in use. The method employed here is not part of one of the Magic Formula publications by 
Pacejka, but is an in-house development of MSC.Software. One of the benefits of using the friction 
ellipse method is that it reduces the number of required input parameters, thereby reducing the amount 
of tire testing needed. If the user supplies the coefficients for the combined slip cosine 'weighing' 
functions in the tire property file, the combined slip is calculated according to combined slip with cosine 
'weighing' functions (standard method). If no coefficients are supplied, the model will switch to the so-
called friction ellipse which is used to estimate the combined slip forces and moments and this switch 
will be reported on the screen and in the .msg file during run time.

For an example, see Knowledge Base Article 1-43315506.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315506

Adams/Vibration

Nastran Modal Export for Frequency Domain Stress Recovery
Forced vibration analysis results from Adams/Vibration can now be used to recover stress (or strain) on 
a flexible body in the frequency domain using MSC Nastran. Modal deformations of a flexible body are 
now easily exported in Nastran format. When the Adams/Vibration plugin is loaded, this feature can be 
accessed from the Vibration menu under Review -> Nastran Modal Export. After you have performed 
a forced vibration analysis of a flexible body model you simply use that information, provide an output 
file name as well as the start and end frequencies you want to output to Nastran, and a binary modal 
deformation file (.mdf) will be written.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43315506
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Sample Command Language:

!---export modal deformations to Nastran
mdi vibration export_q  &
  vibr_analysis = .model_1.TIP_Forced_Vibration  &
  flex_body = .model_1.FLEX_BODY_3  &
  file_name = "test.mdf"  &
  start_freq = 300  &
  end_freq = 2000 

Nastran Stress Recovery is the process of exporting the modal deformations (coordinates) of a flexible 
body from an Adams/Vibration analysis to Nastran.Rigid body motion of the flexible body is also 
included in the Modal Deformation File (MDF). A Nastran restart analysis can then be performed to 
recover dynamic stresses (or strains) on the finite-element model of the flexible body. 

For an example, see Knowledge Base Article 1-43125354.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43125354

Stress FRF
Stress (and Strain) Frequency Response Function (FRF) at grid locations on a flexible body can now be 
plotted in Adams/PostProcessor. A new Nodal Info menu button is available under the Vibration -> 
Build menu when the Adams/Vibration plug-in is loaded. Note that the Modal Neutral File (MNF) for 
the flex body is required to contain stress and/or strain modes.

You can create Nodal Info object(s) by entering the flexible body, a list of node ids, and the criterion of 
interest (Von Mises, Maximum Shear, Normal X, etc.). From the Plotting dashboard for Vibration 
Analysis you can then select Source to be Stress FRF (or Strain FRF) to plot the Nodal Info objects you've 
created.

Sample Command Language:

!---create nodal info
vibration stress_strain_nodal_info create &
  stress_strain_nodal_info_name=.model_1.Nodal_Info_1 &
  flex_body=.model_1.Flexible_Body_2 &
  nodes = 31, 32, 33, 1424 &
  criterion=vonmises

Nodal Info objects are retained as part of the vibration model when you save it, allowing you to reuse or 
modify them later on. A nice feature of the "Nodal Info" object is that it does not have to be created prior 
to running a vibration analysis -- you can create it afterward and the Stress/Strain FRFs can still be 
plotted.

For an example, see Knowledge Base Article 1-43084321.

Note:  Stress and strain contour plots of flexible bodies are not supported in vibration animation. 
Please see Known Issue article 1-24544891 in the knowledge base for further details.

http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43125354
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-43084321
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Adams/View

Command Language Reference Guide
Newly available in this release is a more complete set of documentation for the Adams/View Command 
Language. Many commands that were never documented before are now covered and are presented in 
an easy-to-read format that includes Format, Example, and Description sections as well as Extended 
Definition, Caution and Tips sections, where applicable. Look for “View Command Language” under 
“Adams/View” help beneath “Adams Basic Package”

Overall Documentation Enhancements
For Adams, we've improved the help system to help you more easily find information.

• Combined tables of contents (TOCs) - We've organized the TOCs to reflect the new Adams 
packaging so you can easily access the product help. 

• Improved TOC and search pane - You can now expand and close the pane on the left side of 
the help window that contains the TOC and search results. The TOC also contains automatic 
sync to show you where your current topic is in the TOC. 

• Integrated master site - You can now access all product documentation from one master site 
and search globally across all products. The master site can be accessed from the Help menu 
(Adams Help). Product specific help is also available, including indexes where applicable.

• Printable versions of material - You can view the online documentation in PDF format (for 
printing purposes). Select the PDF button on the upper right hand side of the help system to open 
the PDF version of the help topic. 

• New Favorites tab - You can easily bookmark a page in the help system using the Add button 
under Favorites tab

• All Products help button - You can easily access the help system for all the products using the 
All Products help button from anywhere in the help system
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Starting Adams Products
This sections described how you can start your Adams products on UNIX and on Windows.

Starting Adams Products on UNIX
The Adams Toolbar is a starting point to using Adams products on UNIX. The toolbar is shown below.

You can also use the Adams Toolbar to:

• Customize, keep track of, and organize multiple libraries of standard Adams products
• Create binaries
• Manage custom memory models and product preferences

For more information on these or other Adams Toolbar operations, see the Running and Configuring 
online help (from the Help menu in any product, select Adams Help, on the left pane, select 
Configuring Adams).

To start a product on UNIX:
1. To display the Adams Toolbar, at the command prompt, enter the command adams07x where x 

is the version number, for example adams07r1.
2. Click on the tool representing the product you want to start.

Adams Toolbar tool - Right click to set up Toolbar, manage 
memory models, access online help and Technical Support 
resources and more

Product tools - Click to run product or right-
click to configure products and create user 
libraries.

Hold the cursor over a tool to see the name of 
the associated product.
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Starting Adams Products on Windows
You start any Adams product from the Start menu. You can also use the Start menu to:

• Change your license type
• Generate problem reports 
• Uninstall products, demonstrations, and documentation
• Set Adams preferences

For more information on these or other operations, see the Running and Configuring online help.

To start a product on Windows:
• From the Start menu, point to Programs, point to MSC.Software, point to MSC Adams 2007 

r1, point to the name of the product you want to start, and then select the product type. For 
example, point to ACar, and then select Adams - Car.

Note:  We recommend that you use the Adams Toolbar to start your Adams products, but 
if you want to automate certain operations, use the text-based Program Menu. For 
more information, see the Running and Configuring online help.

Tip: Select the corresponding desktop icon for the product, if you installed it on your 
desktop. 



Adams 2007 r1 Release Guide
  

18
Setting Preferences
This section describes how you can set preferences, such as your working directory, graphics setting, and 
memory model size.

Setting Preferences on UNIX
You use the Registry Editor from the Adams Toolbar to set a variety of preferences. For information on 
the preferences you can set, see the Running and Configuring online help.

To display the Registry Editor:
• From the Adams Toolbar, right-click any product tool, and then select Change <Product 

Name> Settings.

Setting Preferences on Windows
You use the Settings menu to modify:

• Graphics settings
• HOOPS settings
• Memory model size

To display the Settings dialog box:
• From the Start menu, point to Programs, point to MSC.Software, point to MSC Adams 2007 

r1, and then select Adams - Settings.
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Setting Your Working Directory
During a session in a default or custom product, you can select the directory where you want to place 
your model and output files.

For Adams/Adams/View, you can set the working directory from the Welcome dialog box. 

To set your working directory:
1. From the File menu, select Select Directory.
2. In the dialog box that appears, select the working directory.
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Tool Tips
Tool tips display information about the item the cursor is currently over in an Adams product. The 
following shows the tool tip that appears when you place the cursor over the link geometry tool.

To display tool tips:
• Move the cursor over the item in the interface on which you’d like information.

A brief description of the item appears.

Tool
Tip
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Online Help
To help you use the Adams products, MSC.Software provides online help (HTML format). To view the 
online help and tutorials, you can use your default Web browser. An example of online help is shown 
below

Products grouped
by package

Search for documentation
across entire Help system

Bookmark topics of
interest

Navigate to next
topic or previous
topic

Automatic sync to
show the current
topic in TOC

All Products
Help Button
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Versions of Web Browsers
For the Adams Help system, all you need is a Windows, Macintosh, or UNIX computer running a fairly 
new browser with JavaScript enabled. If JavaScript is not enabled, then the Help set will not display in 
its entirety. You also need to have appropriate Acrobat reader to view PDF files from online help system. 
We recommend that you view the online help using one of the following browsers:

• Internet Explorer 5.x or 6.x 
• Netscape Navigator 7.x or 8.x 
• Mozilla/Firefox 1.x
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Accessing the Online Help
You can view help for a dialog box, a product, or for all Adams products. The figure below shows the 
help for all Adams products, called the integrated master site. You can use this site to view any product’s 
help and search across all product help. You can also access frequently asked questions, release notes for 
all products, and view the documents in Adobe Reader. 

View
topics for
any product’s 
help

Use to view
PDF

Print
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To get help on a dialog box:
1. Click in the dialog box for which you need help.
2. Press F1.

Adams launches a browser window that contains information about the dialog box. 

To get general help on your product:
• From your product’s Help menu, select Product Name Help (where Product Name is the name 

of your Adams product).
Adams launches a browser window that contains the starting point for your product’s online 
help.

To get help on another Adams product:
• Perform one of the following:

• If you’re in an Adams product, from its Help menu, select Adams Help.
• If you’re in the help for an Adams product, use the “All Products Help” button ( )to get to 

main help system. 
Your default browser starts and displays the master site for Adams online help.

To open the Adams online help from the Adams Toolbar:
• Right-click the Adams Toolbar tool, and then select Online Help.

Your default browser starts and displays the master site for Adams online help.

To open the Adams online help from the Start Menu:
• From the Start menu, point to Programs, point to MSC.Software, point to MSC Adams 2007 

xx (where xx is the release number), and then select Adams - Online Help.
Your default browser starts and displays the master site for Adams online help.
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Navigating through the Help
You navigate through the Adams help system as you do through any help system, selecting topics in the 
pane on the left. In addition, we’ve provided:

• Navigation arrows  at the top of the pane to let you scroll through topics one at a 
time. 

• Automatic sync  to show you where your current topic is in the table of contents (TOC). 
This is very helpful if you, for example, search for a topic and want to know if there are more 
topics on the subject. It shows you where the topic is in the TOC, allowing you to see whether or 
not there are more topics with it. 
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Searching
You can search all the help files in HTML format for a particular product or all Adams products. 

If you are in a product specific help
1. Open the online help for your product.

2. Press Search button at the top of the help window, enter the search text, and then 
press the Go button .

The results appear in the pane on the left, replacing the table of contents.
3. Click the topic you want to view.

If you are in Adams help system
1. Press search button at the top of help window, which will give an option to search All Available 

products or A single product.
2. Enter the search text and follow Steps 2 and 3 above

Printing

To print a file:

• In the help system you can select the Print button . to print the topic that you are viewing

• You can select the PDF button . to see the entire PDF file pertaining to the topic and print 
the file like a regular PDF file. Notice that some of the images in PDF file may be cropped.

Index
The Index tab displays an alphabetical list of keywords associated with help topics. To view index entries, 
you can select a letter group to display the entries for that group. When you click on an index entry, the 
related topic will display in the topic frame. You can select Indexes in a product specific help or in the 
main help system.
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Tutorials and Examples
Adams products have a set of tutorials or getting started guides that step you through examples of using 
the product’s features, as well as introduce the basic concepts of the product. The getting started guides 
are online. In addition, many of the products have examples of its features that are stored in Knowledge 
Base Articles. 

You will find links to all the tutorials and examples for a product under its Examples tab.

To access the tutorials and examples:
• From the online help for a product, from the pane on the left, select Examples. 
• From the online help, from the left pane, select Getting Started and select the product that you 

are interested in.

Adams/View Examples

Getting Started Guides
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4 Supported Versions of 
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Support for Easy5 and MATLAB

Easy5
This release of Adams/Controls is certified to run with Easy5 2005 r1 SP2. Note Easy5 2005 r1 does not 
support SGI-IRIX.

Platform support is subject to change. For the latest information, see the Easy5 2005 r1 Hardware and 
Software Requirements at:

http://www.mscsoftware.com/products/easy5_support.cfm

MATLAB
The supported versions of MATLAB are R14SP3 (MATLAB 7.1, Simulink 6.3) and 2006b. Note that 
MATLAB R14SP3 and 2006b do not support IBM platforms. For more information on R14 platforms 
and compatibility, see:

http://www.mathworks.com/support/sysreq/release14sp3/unix.html 

For further information regarding UNIX platform support for Adams/Controls, see Knowledge Base 
Article 12445: http://support.adams.com/kb/faq.asp?ID=kb12445.dasp

Note:  If you want to co-simulate with Easy5 and you are running Adams/Controls on one of the 
platforms that Easy5 does not support, you should consider using TCP/IP communication. 
This allows Adams/Controls to communicate with Easy5 even though the codes are 
running on different platforms.

Note:  If you want to co-simulate with MATLAB and you are running Adams/Controls on one of 
the platforms that is not supported by MATLAB, you should consider using TCP/IP 
communication. This allows Adams/Controls to communicate with MATLAB even though 
the codes are running on different platforms.

http://support.adams.com/kb/faq.asp?ID=kb12445.dasp
http://www.mscsoftware.com/products/easy5_support.cfm
http://www.mathworks.com/support/sysreq/release14sp3/unix.html
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Supported Versions of Integration Products

Company Product Name Product Version
Adams Package 

(Product) Platform
The Mathwoks, 
Inc.

Release 14 SP3
MATLAB
Simulink
Real-Time 
Workshop

Release 2006b
MATLAB
Simulink
Real-Time 
Workshop

Version 7.1
Version 6.3
Version 6.3

Version 7.3
Version 6.5
Version 6.5

Adams Advanced 
Package 
(Adams/Controls) 1

HP HP-UX 11i 
Red Hat Enterprise Linux 4
Sun Solaris 8, 9, 10
Windows 2000
Windows XP Professional 
Windows XP Professional X

MSC.Software 
Corporation

Easy5 2005 r1 SP2 (8.0.4) and 
2005 r1 SP3 (8.0.6)

Adams Advanced 
Package 
(Adams/Controls) 1

HP HP-UX 11i
IBM AIX 5.3 
Red Hat Enterprise Linux 4
Sun Solaris 8, 9, 10
Windows 2000
Windows XP Professional 

ANSYS, Inc. ANSYS V6.0 and above 

V5.4 and above 

Adams Advanced 
Package 
(Adams/Durability)

Adams Advanced 
Package 
(Adams/Flex)

UNIX and Windows

Hibbitt, 
Karlsson & 
Sorensen, Inc. 
(HKS) 

ABAQUS/ADAMS Version 6.3 and above 

Version 6.1-1 and 
above 

Adams Advanced 
Package 
(Adams/Durability)

Adams Advanced 
Package 
(Adams/Flex)

UNIX and Windows

MSC.Software 
Corporation

Fatigue 2001 and above Adams Advanced 
Package 
(Adams/Durability)

UNIX and Windows
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MSC.Software 
Corporation

Marc 2005 and above

2003 and above

Adams Advanced 
Package 
(Adams/Durability)

Adams Advanced 
Package 
(Adams/Flex)

UNIX and Windows

MSC.Software 
Corporation

MSC.Nastran V69.X and above Adams Advanced 
Package 
(Adams/Durability)

Adams Advanced 
Package 
(Adams/Flex)

UNIX and Windows

nCode FE-Fatigue Version 5.2 and above Adams Advanced 
Package 
(Adams/Durability)

UNIX and Windows

UGS PLM 
Solutions

I-DEAS 
Mechanism Design

I-DEAS NX 10 and 
above

I-DEAS 8, 9, NX 10 
and above

Adams Advanced 
Package 
(Adams/Durability)

Adams Advanced 
Package 
(Adams/Flex)

UNIX and Windows

Company Product Name Product Version
Adams Package 

(Product) Platform

Notes:  1 Adams/Controls, in the Adams Advanced Package, is supported on all the platforms 
listed in the Adams 2007 r1 Hardware and Software Specification. However, partner 
product support varies. Please see the Knowledge Base Article 1-53024309 for 
details regarding the availability of controls software on platforms. 

http://www.mscsoftware.com/support/prod_support/adams/hw_specs/2007r1_hwsw.cfm
http://support.mscsoftware.com/kb/results_kb.cfm?S_ID=1-53024309&amp;requestTimeout=2000
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